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RZ/A3UL, RZ/A3M 
Getting Started with RZ/A Flexible Software Package 
Introduction 
This manual describes how to use the RZ/A Flexible Software Package (FSP) for developing applications for 
the RZ microprocessor series. 

Target Device 
RZ/A3UL 

RZ/A3M 
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1. Introduction 
1.1 Overview 
This application note describes how to use the Renesas RZ/A Flexible Software Package (FSP) running on 
the Cortex®-A55 (hereinafter referred to as CA55) incorporated on RZ/A3UL and RZ/A3M. 

 

1.2 Introduction to FSP 
1.2.1 Purpose 
The Renesas RZ/A Flexible Software Package (FSP) is an optimized software package designed to provide 
easy to use, scalable, high-quality software for embedded system design. The primary goal is to provide 
lightweight, efficient drivers that meet common use cases in embedded systems. 

 
1.2.2 e2 studio IDE 
FSP provides a host of efficiency enhancing tools for developing projects targeting the Renesas RZ series of 
MPU devices. The e2 studio IDE provides a familiar development cockpit from which the key steps of project 
creation, module selection and configuration, code development, code generation, and debugging are all 
managed. 

 

1.3 Limitations 
1.3.1 Hardware Initial Setup 
RZ/A FSP expects the initial setup of hardware to be carried out beforehand by RZ/A Initial Program Loader 
(hereinafter referred to as IPL). For detail on IPL, please refer to the Document of IPL. 

 
  

https://github.com/renesas/rza-initial-program-loader
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2. Starting Development Introduction 
2.1 e2 studio setup 
2.1.1 What is e2 studio? 
Renesas e2 studio is a development tool encompassing code development, build, and debug. e2 studio is 
based on the open-source Eclipse IDE and the associated C/C++ Development Tooling (CDT). 

When developing for RZ MPUs, e2 studio hosts the RZ/A FSP. The FSP provides a wide range of time 
saving tools to simplify the selection, configuration, and management of modules and threads, to easily 
implement complex applications. 

 
2.1.2 e2 studio Prerequisites 
2.1.2.1 Obtaining an RZ MPU Kit 
To develop applications with RZ/A FSP, start with RZ/A3UL Evaluation Board Kit and EK-RZ/A3M. 

RZ/A3UL Evaluation Board Kit related information is available at RZ/A3UL Evaluation Board Kit. 

EK-RZ/A3M related information is available at EK-RZ/A3M Evaluation Kit for RZ/A3M MPU. 

The relationship between the board type and the board name on e2 studio is as follows. 

 Board name on GUI 
screen 

Note 

RZ/A3UL Evaluation 
Board Kit QSPI Edition 
(RTK9763U02S01000BE) 

RZ/A3UL Evaluation Board 
Kit QSPI Edition (Exec with 
DDR SDRAM) 

If you select this, the initial program loader 
will transfer the entire program including the 
code area to DDR4. 

RZ/A3UL Evaluation Board 
Kit QSPI Edition (eXecute-In-
Place) 

If you select this, only the data area will be 
transferred to DDR4 by the initial program 
loader. The code area on the flash ROM is 
referenced during execution. 

RZ/A3UL Evaluation 
Board Kit Octal-SPI 
Edition 
(RTK9763U02S01001BE) 

RZ/A3UL Evaluation board 
Kit OCTAL Edition (eXecute-
In-Place) 

If you select this, only the data area will be 
transferred to OctaRAM by the initial 
program loader. The code area on the flash 
ROM is referenced during execution. 

EK-RZ/A3M 
(RTK9EKZA3MS10001BE) 

EK-RZ/A3M NOR Boot (Exec 
with DDR SDRAM) 

If you select this, the initial program loader 
will transfer the entire program including the 
code area to Built-in DDR3. 

 
2.1.2.2 PC Requirements 
The following are the minimum PC requirements to use e2 studio: 

• Windows 10 or Ubuntu 22.04 LTS Desktop(64-bit) with Intel i5 or i7, or AMD A10-7850K or FX 
• Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred) 
• Minimum 250-GB hard disk 

 
2.1.2.3 Licensing 
FSP licensing includes full source code, limited to Renesas hardware only. 

2.1.3 e2 studio installation for Windows PC 
This chapter describes how to install the e2 studio IDE on Windows PC. If you would like to install e2 studio 
and FSP at the same time, please jump to 2.2.1. 

2.1.3.1 Download 
The latest e2 studio IDE installer package can be downloaded from Renesas website for free. Please check 
detailed information from: https://www.renesas.com/e2studio. Note that user has to login to the Renesas 
account (in MyRenesas page) for the software download. 

  

https://www.renesas.com/products/microcontrollers-microprocessors/rz-mpus/rza3ul-evaluation-board-kit-rza3ul-evaluation-board-kit
http://www.renesas.com/ek-rza3m
https://www.renesas.com/e2studio
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2.1.3.2 Installation of e2 studio IDE 
1. Double-click the e2 studio installer to launch the e2 studio installation wizard. Then, select the [Custom 

Install] option and click the [Next] button. 

   

Figure 1: e2 studio installation wizard 
Note: 

If you are using a multi-user environment, you may receive a prompt to confirm whether you want to 
install it for the current user only or for all users. 

 

Figure 2: Select User for Installation 
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2. Welcome page 
User can change the install folder by clicking [Change…]. Click [Next] to continue. 

 
Note: 
 1. If you would like to have multiple versions of e2 studio, please specify new folder here. 
 2. Multi-byte characters cannot be used for e2 studio installation folder name. 

 

Figure 3: Installation of e2 studio – Welcome page 
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3. Device Families 
Select Devices Families to install. Click the [Next] button to continue. 

 

Figure 4: Installation of e2 studio – Device Families 
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4. Extra Features 
Select Extra Features (i.e., Language packs, Git support…) to be installed. For non-English language 
users, please select Language packs at this step if needed. Then, click the [Next] button to continue. 

 

Figure 5: Installation of e2 studio – Extra Features 
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5. Customize Features 
Select the components to install and click the [Next] button to continue. Be sure to choose “Renesas FSP 
Smart Configurator Core”. Otherwise, FSP won’t be built on e2 studio successfully. 

 

Figure 6: Installation of e2 studio – Features 
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6. Additional Software 
Select additional software (i.e., compilers, utilities, QE…) to be installed. Be sure that you select the 
“GCC toolchains & Utilities” tab, choose the following items, and click [Next] to continue. 
 
• GCC ARM A-Profile (AArch64 bare-metal) 13.2 rel1 
 

 

Figure 7: Installation of e2 studio – Additional Software 
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7. Licenses Agreement 
Please read and accept the software license agreement, then click the [Next] button. Note that 
acceptance of the license agreement is mandatory; without it, the installation process cannot proceed. 

 

Figure 8: Installation of e2 studio – Licenses 
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8. Shortcuts 
Select a shortcut name for the start menu and click the [Next] button to continue. 

 
Note: 

If e2 studio was installed in another location, it is recommended to rename it to distinguish from the 
other e2 studio(s). 

 

Figure 9: Installation of e2 studio – Shortcuts 
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9. Summary 
On the summary page, a list of components to be installed will be displayed. Please review the contents 
and click the [Install] button to proceed with the installation of the Renesas e2 studio IDE. 

 

Figure 10: Installation of e2 studio – Summary 

 
10. Installing… 

The installation will proceed. Depending on selected items of the additional software, new dialog prompts 
may appear during the installation process. Please follow the instructions provided by the installer when 
this occurs. 
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11. Results 
If the installation has been successfully completed, you should see the following information.  

 

Figure 11: Results Page 
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2.1.4 e2 studio installation for Linux PC 
This chapter describes how to install the e2 studio IDE on Linux PC. 

2.1.4.1 Prerequisite 
Please download the development tool related stuff: 

• SEGGER J-Link driver 
Please download the driver V8.10a: 
https://www.segger.com/downloads/jlink/JLink_Linux_x86_64.deb 

 
• e2 studio IDE installer 

The latest e2 studio IDE installer package can be downloaded from Renesas website for free. Please 
check detailed information from: https://www.renesas.com/e2studio. 

 
2.1.4.2 Installation 
This section describes the procedure of each software installation. Filename, version number and the file 
path are just examples. Please replace those in accordance with your environment. 

• Segger J-Link driver 
Open a terminal window and enter the commands stated below: 

 
$ sudo dpkg -i JLink_Linux_V810a_x86_64.deb 
 
If the previous installation fails with unmet dependencies, please retry as follows: 

 
$ sudo apt-get -f install 
$ sudo dpkg -i JLink_Linux_V810a_x86_64.deb 
 

• e2 studio 
1. Run the e2 studio IDE Installer “./e2studio_installer-yyyy-mm_linux_host.run”. (Before running the 

installer, check the execution permission of the installer. 
2. User needs to select Install Type as shown below. In this material, it is expected that Custom Install is 

selected. Then, click [Next >] to continue. 

 

Figure 12: Selection of Install Type 
  

https://www.segger.com/downloads/jlink/JLink_Linux_x86_64.deb
https://www.renesas.com/e2studio
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3. User can change the install folder by clicking [Change…]. Click [Next] to continue. 
 
Note: 
 1. If you would like to have multiple versions of e2 studio, please specify new folder here. 
 2. Multi-byte characters cannot be used for e2 studio installation folder name. 

 

Figure 13: Installation of e2 studio – Welcome page 

 
3. Device Families 

Select Devices Families to install. Click the [Next] button to continue. 
 

 

Figure 14: Installation of e2 studio – Device Families 
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4. Extra Features 
Select Extra Features (i.e., Language packs, SVN & Git support, RTOS support…) to be installed. For 
non-English language users, please select Language packs at this step if needed. Then, please click the 
[Next] button to continue. 

 

 

Figure 15: Installation of e2 studio – Extra Features 

 
5. Customize Features 

Select the components to install and click the [Next] button to continue. Be sure that “Renesas FSP Smart 
Configurator Core” is certainly selected. 

 

 

Figure 16: Installation of e2 studio – Features 
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6. Customize Features 
Select additional software (i.e., compilers, utilities, QE…) to be installed. Be sure that you select the 
“GCC toolchains & Utilities” tab, choose the following items, and click [Next] to continue. 
 
• GCC ARM A-Profile (AArch64 bare-metal) 13.2 rel1 
 

 

Figure 17: Installation of e2 studio – Additional Software 

 
7. License Agreement 

Read and accept the software license agreement. Click the [Next] button. Please note that user must 
accept the license agreement, otherwise installation cannot be continued. 

 

 

Figure 18: Installation of e2 studio – Licenses 
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8. Shortcuts 
Select shortcut name for start menu and click [Next] button to continue. 

 

 

Figure 19: Installation of e2 studio – Shortcuts 

 
9. Summary 

Components list to be installed is shown. Please confirm the contents and click the [Install] button to 
install the Renesas e2 studio IDE. 

 

 

Figure 20: Installation of e2 studio – Summary 
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10. Installing... 
The installation is performed. Depending on selected items of additional software, new dialog prompts 
may appear during the installation process. Please see chapter 2.1.3.2 for more detailed information. 

 
11. Results 

If the installation is successfully done, you should see the following information.  
 

 

Figure 21: Summary Page 
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2.2 FSP setup 
In this section, 3 ways of FSP installation are described. However, at this moment, platform installer won't be 
available and so, please install FSP based on either 2.2.2 or 2.2.3. 

2.2.1 Installation of FSP Packs using Platform Installer 
This section describes how to install FSP using Platform Installer setup_rzafsp_v3_5_0_e2s_v2025-01.exe 
showcased at here. 

1. Double-click setup_rzafsp_v3_5_0_e2s_v2025-01.exe, select either [Quick Install] or [Custom Install] 
and click [Next >] when the installation wizard is shown. When you choose [Quick Install], you can jump 
to 6. Licenses. 

 
Note: 

If e2 studio was installed in your PC, the option to upgrade the existing version or install e2 studio to a 
different location will be displayed. 

 

Figure 22: FSP Platform Installation Wizard 

 
2. Welcome page 

User can change the install folder by clicking [Change…]. Click [Next] to continue. 
 
Note: 
 1. If you would like to have multiple versions of e2 studio, please specify a new folder here. 
 2. Multi-byte characters cannot be used for e2 studio installation folder name. 

https://github.com/renesas/rza-fsp/releases
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Figure 23: FSP Platform Installer – Welcome page 

 
3. Extra Features 

Select Extra Features (i.e., Language packs, SVN & Git support, RTOS support…) to be installed. For 
non-English language users, please select Language packs at this step if needed. Then, click the [Next] 
button to continue. 

 

 

Figure 24: FSP Platform Installer – Extra Features 
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4. Customize Features 
Essential features have already been selected. If you would like to install additional features, please 
check those and then click [Next >]. 

 

 

Figure 25: FSP Platform Installer – Features 
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5. Additional Software 
All the software is selected by default. click [Next >]. 

 

 

Figure 26: FSP Platform Installer – Additional Software 

 
6. Licenses 

Please read and accept Software License Agreements to be listed and click [Next >]. 
 

 

Figure 27: FSP Platform Installer – Licenses 

 
7. Shortcuts 

Select shortcut name for start menu and click [Next] button to continue. 
 
Note: 

If e2 studio was installed in another location, it is recommended to rename it to distinguish it from the 
other e2 studio(s). 
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Figure 28: FSP Platform Installer – Shortcuts 

 
8. Summary 

Components list to be installed is shown. Please confirm the contents and click the [Install] button to 
install the Renesas e2 studio IDE. 

 

 

Figure 29: FSP Platform Installer – Summary 

 
10. Installing... 

The installation is performed. Depending on selected items of additional software, new dialog prompts 
may appear during the installation process. At that time, please follow the instruction the installer 
indicates. 

 
11. Results 

If the installation is successfully done, you should see the following information. 
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Figure 30: Installation Results of FSP Platform Installer 

 
2.2.2 Installation of FSP Packs using Package Installer 
Package Installer RZA_FSP_Packs_v3.5.0.exe is showcased at here. Please note that it’s for Windows 
Host PC only. 

Here is the procedure: 

1. Exit e2 studio. 
2. Invoke RZA_FSP_Packs_v3.5.0.exe. 
3. Click [Next >] to start the installation. 
 

 

Figure 31: FSP Package Installer 

4. See the license term and click [I Agree] if it’s acceptable 
 

https://github.com/renesas/rza-fsp/releases
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Figure 32: FSP License Term 

 
5. Specify e2 studio installation folder (e.g., C:\Renesas\e2studio) and click [Install]. 
 

 

Figure 33: FSP Installation 

 
6. Click [Finish] to complete the installation. 
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Figure 34: Completion of FSP Installation 

 
If the box Open up documentation for this release is checked at that time, FSP documentation for the 
installed version of FSP should be opened. 
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2.2.3 Installation of FSP Packs using Package Zip file 
No Package installer is available for Linux Host PC and therefore, you need to install FSP Packs with 
RZA_FSP_Packs_v3.5.0.zip. This section describes how to do install it. Please note that the same 
installation procedure is valid for Windows Host PC. 

 

1. Download RZA_FSP_Packs_v3.5.0.zip from here. 
2. Extract the zip file to e2 studio installation directory. 

If the FSP Packs are successfully extracted, rz_fsp/rza/packs directory is placed at the location below: 
• <e2 studio installation directory>/internal/projectgen 

   

Figure 35: FSP Packs in e2 studio installation directory 

3. At the 1st invocation of e2 studio after you carry out the above procedure, FSP Packs should be installed 
automatically. 

 

https://github.com/renesas/rza-fsp/releases/tag/v3.2.0
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4. You can check if the installation is successfully done by the following procedure: 
Click Help > CMSIS Packs Management > Renesas RZ/A. 

  
 

If FSP is successfully installed, 3.5.0 should be listed under FSP as shown below: 
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3. Set Up a Target Board 
Below is an example of a typical system configuration. 

 

Figure 36: System Configuration Example – SMARC EVK 
 

 

Figure 37: System Configuration Example – EK-RZ/A3M 

 
 

3.1 Supported Debugger 
• SEGGER J-Link 

For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER – the Embedded Experts. 
In the case of EK-RZ/A3M, the on-board debug functionality is provided using Renesas RA4M2 Debug 
MPU and SEGGER J-Link® firmware as J-Link OB. For detail, please refer to 3.2.2. 

 
  

https://www.segger.com/products/debug-probes/j-link/
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3.2 Board Setup 
3.2.1 Boot Mode 
For the SMARK EVK, set up the SW11 as follows to configure Boot Mode 3 (QSPI or OCTA Boot (1.8V) 
Mode). 

 

Figure 38: Boot MODE – SMARC EVK 

 
For the EK-RZ/A3M, set up the SW5 as follows to configure Boot Mode 4 (Boot from 3.3V QSPI NOR flash). 

 

Figure 39: Boot MODE – EK-RZ/A3M 
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3.2.2 JTAG connection 
When connecting JTAG to SMARC EVK, you must set the DIP SW1 settings as follows: 

 

Figure 40: JTAG connection – SMARC EVK 

 
Please note that RZ/A3UL SMARC EVK has CoreSight 10 connector and therefore, the following adapter 
must be needed to connect Segger J-Link. 

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/ 

 
In the case of EK-RZ/A3M, the on-board debug functionality is supported. User can debug by connecting 
DEBUG1 connector on EK-RZ/A3M with PC. When use on-board debug functionality, you must set the J9 as 
follows. 

 

Figure 41: JTAG connection – EK-RZ/A3M 
 

  

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/
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3.2.3 Debug Serial (console output) 
For SMARC EVK, debug serial uses CN14. The baud rate is 115200bps. 

 

Figure 42: Debug Serial (console output) – SMARC EVK 

 
For EK-RZ/A3M, on-board debug functionality supports debug serial output. You must configure the J-Link 
OB to enable the Virtual COM-Port after connection the board to your PC. And the baud rate is 115200bps. 

 

Figure 43: Debug Serial (console output) – EK-RZ/A3M 
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3.2.4 Power Supply 
Here are the proven power supply related goods to be used in Renesas’ development. Please prepare for 
the equivalent ones for your development. 

• USB Type-C cable CB-CD23BK (manufactured by Aukey) 
• USB PD Charger Anker PowerPort III 65W Pod (manufactured by Anker) 

 

 

Figure 44: Power Supply 

 
For power supply, please follow the following procedure: 

SMARC EVK 

1. Connect USB-PD Power Charger to USB Type-C Connector (CN6). 
Once USB-PD Power Charger is connected to the CN6, LED1 (VBUS PWR ON) and LED3 (Module PWR 
ON) should light up. 

2. Press the power button (SW9) to turn on the power 
When turning on the power, you need to press and hold the power button for 1 second. Also, the power 
button should be pressed and held for 2 seconds for turning off the power. 

3. If the power supply is successful, LED4 (Carrier PWR On) should light up. 
 

 

Figure 45: LED Status after Turning on EVK – SMARC EVK 
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EK-RZ/A3M 

1. Connect DEBUG1(J10) connector of EK-RZ/A3M with PC. 
When powered, the white LED near the center of the board (the “dash” in the EK-RZ/A3M name) will 
illuminate. 

 

 

Figure 46: LED Status after Turning on – EK-RZ/A3M 
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3.2.5 How to check if your board is operational 
This section describes how to check if your board is operational. 

1. Connect the board to your development PC as described in 3.2.3. 
2. Turn on the board as described in 3.2.4. 
3. Launch Terminal Software (e.g., Tera Term). 
4. Establish the connection between the board and development PC as shown in the figure below: 
 

 

Figure 47: Establishment of connection between Target board and Development PC 

5. You should see the following message on your Terminal Software. You can ignore the keyword “error” 
since the cause of error is that nothing is programmed to Flash memory by default. 

 

 

Figure 48: Message on your terminal at the 1st power-up 

 

4. Tutorial: Your First RZ MPU Project - Blinky 
4.1 Tutorial Blinky 
The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the steps of 
creating a simple application using e2 studio and running that application on an RZ MPU board. 

4.2 What Does Blinky Do? 
The application used in this tutorial is Blinky, traditionally the first program run in a new embedded 
development environment. 

Blinky is the "Hello World" of microprocessors. If the LED blinks you know that: 

• The toolchain is set up correctly and builds a working executable image for your chip. 
• The debugger has been installed with working drivers and is properly connected to the board. 
• The board is powered up and its jumper and switch settings are probably correct. 
• The microprocessor is alive, the clocks are running, and the memory is initialized. 
• Timer (GTM) interruption is intentionally fired and GPIO is properly controlled. 
 
Note: 

SRMAC EVK board does not have any LED. Thus, the Blinky sample application used in this tutorial 
is designed to use the Pmod module described below alternatively: 
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• Pmod LED (Four High-brightness LEDs): 
https://reference.digilentinc.com/pmod/pmodled/start 

 

 

Figure 49: Connection Pmod LED module (410-076) 

 
This module is not included on the SRMAC EVK board and so, please prepare it beforehand. 

In the case of EK-RZ/A3M, there are User LEDs on the board. 

 

4.3 Creating a New Project for Blinky 
The creation and configuration of an RZ/A C/C++ FSP Project is the first step in the creation of an 
application. The base RZ/A pack includes a pre-written Blinky example application. 

Follow these steps to create an RZ MPU project: 

1. In e2 studio, click [File] > [New] > [C/C++ Project]. 
 

 

Figure 50: New C/C++ Project 

 
2. Select [Renesas RZ] > [Renesas RZ/A C/C++ FSP Project] and Click Next. 
 

 

Figure 51: Renesas RZ/A C/C++ FSP Project 

3. Assign a name for this new project. Blinky is a good name to use for this tutorial. 
4. Click Next. The Project Configuration window shows your selection. 
 

https://reference.digilentinc.com/pmod/pmodled/start
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Figure 52 : e2 studio Project Configuration window (part 1) 

 
5. Select the board support package corresponding to the package you would like to use, GCC ARM A-

Profile (AArch64 bare-metal) and 13.2.1 from the Device Selection drop-down list, Toolchains and 
Version Selection drop-down list respectively. Then, Click [Next]. 

 

 

Figure 53 : e2 studio Project Configuration window (part 2) 
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6. Select the Build Artifact and RTOS. 
 

 

Figure 54 : e2 studio Project Configuration window (part 3) 

 
7. Select the Blinky template for your board and click Finish. 
 

 

Figure 55 : e2 studio Project Configuration window (part 4) 

 
Once the project has been created, the name of the project will show up in the Project Explorer window of  
e2 studio. Now click the Generate Project Content button in the top right corner of the Project 
Configuration window to generate your board specific files. 
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Figure 56 : e2 studio Project Configuration tab 

 
Your new project is now created, configured, and ready to build. 

 
4.3.1 Details about the Blinky Configuration 
The Generate Project Content button creates configuration header files, copies source files from templates, 
and generally configures the project based on the state of the Project Configuration screen. 

For example, if you check a box next to a module in the Components tab and click the Generate Project 
Content button, all the files necessary for the inclusion of that module into the project will be copied or 
created. If that same check box is then unchecked those files will be deleted. 

 
4.3.2 Configuring the Blinky Clocks 
By selecting the Blinky template, the clocks are configured by e2 studio for the Blinky application. The clock 
configuration tab (see 5.2.3.Configuring Clocks) shows the Blinky clock configuration. The Blinky clock 
configuration is stored in the BSP clock configuration file. 

 
4.3.3 Configuring the Blinky Pins 
By selecting the Blinky template, the GPIO pins used to toggle the LED1 are configured by e2 studio for the 
Blinky application. The pin configuration tab shows the pin configuration for the Blinky application (see 
5.2.4.Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file. 

 
4.3.4 Configuring the Parameters for Blinky Components 
The Blinky project automatically selects the following HAL components in the Components tab: 

• r_gtm 
• r_ioport 
• r_mmu 

 
To see the configuration parameters for any of the components, check the Properties tab in the HAL window 
for the respective driver (see 5.2.9.Adding and Configuring HAL Drivers). 

 
4.3.5 Where is main()? 
The main function is located in <project>/rza_gen/main.c. It is one of the files that are generated during the 
project creation stage and only contains a call to hal_entry(). For more information on generated files, see 
Adding and Configuring HAL Drivers. 
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4.3.6 Blinky Example Code 
The blinky application is stored in the hal_entry.c file. This file is generated by e2 studio when you select the 
Blinky Project template and is located in the project's src/ folder. 

The application performs the following steps: 

1. Get the LED information for the selected board by bsp_leds_t structure. 
2. Set the configuration of Timer (GTM) and the callback function that is called when interrupt is fired. 
3. Define the output level HIGH for the GPIO pins controlling the LEDs for the selected board. 
4. Toggle the LEDs by calling “R_BSP_PinWrite((bsp_io_port_pin_t) pin, pin_level)” for writing to the 

GPIO pin in callback function of GTM that is called with the specified interval. 
 
4.4 Build the Blinky Project 
Highlight the new project in the Project Explorer window by clicking on it and build it. There are three ways to 
build a project: 

1. Click on Project in the menu bar and select Build Project. 
2. Click on the hammer icon. 
3. Right-click on the project and select Build Project. 

 

 

Figure 57 : e2 studio Project Explorer window 

 
Once the build is completed, a message shown below is displayed in the build Console window that displays 
the final image file name and section sizes in that image: 

 

Figure 58 : e2 studio Project Build console 
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4.5 Debug the Blinky Project 
4.5.1 Debug prerequisites 
To debug the project on a board, you need 

• The board to be connected to e2 studio 
• The debugger to be configured to talk to the board 
• The application to be programmed to the microprocessor 

 
Applications run from the internal ram or external ram of your microprocessor. To run or debug the 
application, the application must first be programmed to ram by JTAG debugger. SMARC EVK board has an 
JTAG header and requires an external JTAG debugger to the header. 

 
4.5.2 Debug steps 
To debug the Blinky application, follow these steps: 

1. Configure the debugger for your project by clicking [Run] > [Debugger Configurations...]. 
 

 

Figure 59 : e2 studio Debug icon 

or by selecting the drop-down menu next to the bug icon and selecting [Debug Configurations...]. 
 

 

Figure 60 : e2 studio Debugger Configurations selection option 
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2. Select your debugger configuration in the window. If it is not visible, then it must be created by clicking the 

“New” icon in the top left corner of the window. Once selected, the Debug configuration for your Blinky 
project should be displayed. 

 

 

Figure 61 : e2 studio Debugger Configurations window with Blinky project (1) 

 
3. Select the debug configuration for the generated project and select the Debugger tab. 
 

 

Figure 62 : e2 studio Debugger Configurations window with Blinky project (2) 
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4. Select the Connection Settings tab inside the Debugger tab. 
 

 

Figure 63 : e2 studio Debugger Configurations window with Blinky project (3) 
 

5. Change Reset after download to Yes. 

 

Figure 64 : e2 studio Debugger Configurations window with Blinky project (4) 
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6. Select the debug configuration for the generated project and select the Startup tab. 
 

 

Figure 65 : e2 studio Debugger Configurations window with Blinky project (5) 

 
7. Be sure to change the setting in Load type field of Program Binary [Blinky... raw from Image and 

Symbols to Symbols only. 
 

 

Figure 66 : e2 studio Debugger Configurations window with Blinky project (6) 
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8. Click on Add... to launch Add download module window. Then click Workspace..., choose 

rza3ul_smarc_qspi_ipl.srec(*) as module to be downloaded and finally click on OK. 
* If you have selected "RZ/A3UL Evaluation Board Kit OCTAL Edition (eXecute-In-Place)" in board 
selection, use "rza3ul_smarc_octal_ipl.srec" instead. 

 

 

Figure 67 : e2 studio Debugger Configurations window with Blinky project (7) 
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9. Again, click on Add... to launch Add download module window. Then click Workspace..., choose 

BLINKY.srec as module to be downloaded and finally click on OK. 
 

 

Figure 68: e2 studio Debugger Configurations window with Blinky project (8) 

 
10. Add the “set breakpoint enable-memread 0” to Initialization Commands. 
 

 

Figure 69: e2 studio Debugger Configurations window with Blinky project (9) 

 
  



RZ/A3UL, RZ/A3M Getting Started with RZ/A Flexible Software Package 

R01AN6499EJ0350  Rev.3.50  Page 50 of 76 
May.8.25  

11. Check the Set breakpoint at: check box, then, click Debug button. 
 

 

Figure 70: e2 studio Debugger Configurations window with Blinky project (10) 
 
12. Debug session is now started. 
 

 

Figure 71: e2 studio Debugger Configurations window with Blinky project (11) 

 
13. If you see the following window, please click Switch to continue. 
 

 

Figure 72: e2 studio Debugger Configurations window with Blinky project (12) 
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4.6 Details about the Debug Process 
In debug mode, e2 studio executes the following tasks: 

1. Downloading the application image to QSPI/OctaFlash ROM or DDR SDRAM. 
2. Setting a breakpoint at main(). 
3. Setting the stack pointer register to the stack. 

 
This section describes the detail on the debug process of Blinky Project. 

 
4.6.1 Run the Blinky Project 
Click [Run] > [Resume] or click on the Play icon shown below: 

 

Figure 73 : e2 studio Debugger Play icon 

 
Make sure the box Set breakpoint at: is checked and specify main as its value, Program Counter should be 
stopped at main() function. 

 

 

Figure 74 : Set breakpoint at: option 
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Figure 75 : Blinky project in Debug Mode 

 
After that LED should start to blink when clicking [Run] > [Resume] or Play icon again. 
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5. FSP Application Launch with e2 studio 
5.1 Create a Project 
5.1.1 What is a Project? 
In e2 studio, all FSP applications are organized in RZ MPU projects. Setting up an RZ MPU project involves: 

1. Create a Project 
2. Configuring a Project 

 
These steps are described in detail in the next two sections. When you have existing projects already, after 
you launch e2 studio and select a workspace, all projects previously saved in the selected workspace are 
loaded and displayed in the Project Explorer window. Each project has an associated configuration file 
named configuration.xml, which is in the project's root directory. 

 

Figure 76 : e2 studio FSP Configuration Perspective 

 
Double-click on the configuration.xml to open the RZ MPU Project Editor. To edit the project configuration, 
make sure that the FSP Configuration perspective shown below is selected in the upper right-hand corner 
of the e2 studio window. Once selected, you can use the editor to view or modify the configuration settings 
associated with this project. 

 

Figure 77 : e2 studio FSP Configuration Perspective 

 
 
  



RZ/A3UL, RZ/A3M Getting Started with RZ/A Flexible Software Package 

R01AN6499EJ0350  Rev.3.50  Page 54 of 76 
May.8.25  

 
Note: 

Whenever the RZ project configuration (that is, the configuration.xml file) is saved, a verbose RZ 
Project Report file (rza_cfg.txt) with all the project settings is generated. The format allows differences 
to be easily viewed using a text comparison tool. The generated file is located in the project root 
directory. 

 

 

Figure 78 : RZ Project Report 

The RZ Project Editor has several tabs. The configuration steps and options for individual tabs are discussed 
in the following sections. 
 
Note: 

The tabs available in the RZ Project Editor depend on the e2 studio version and the layout may vary 
slightly, however the functionality should be easy to follow. 

 

Figure 79 : RZ Project Editor tabs 
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5.1.2 Creating a New Project 
For RZ MPU applications, generate a new project using the following steps: 

1. Click on [File] > [New] > [C/C++ Project]. 

 

Figure 80 : New RZ MPU Project 

2. Click on the Renesas RZ/A C/C++ FSP Project template for the type of project you are creating. 
 

 

Figure 81 : New Project Templates 
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3. Select a project name and location. 
 

 

Figure 82 : RZ MPU Project Generator (Screen 1) 

 
4. Click [Next]. 
 
5.1.2.1 Selecting a Board and Toolchain 
In the Project Configuration window select the hardware and software environment: 

1. Select the FSP version. 
2. Select the Board for your application. You can select an existing RZ MPU Evaluation Kit or Custom User 

Board for any of the RZ MPU devices with your own BSP definition. (Please refer 2.1.2.1 for more 
information about the RZ MPU Evaluation Kit.) 

3. Select the Device. The Device is automatically populated based on the Board selection. Only change 
the Device when using the Custom User Board QSPI Boot (eXecute-In-Place) board selection. 

4. The Toolchain selection defaults to GCC ARM A-Profile (AArch64 bare-metal). 
5. Select the Toolchain version. This should default to the installed toolchain version. 
6. Select the Debugger. The J-Link Arm Debugger is preselected. 
7. Click Next. 
 

 

Figure 83 : RZ MPU Project Generator (Screen 2) 
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5.1.2.2 Selecting a Project Template 
In the next window, select the build artifact and RTOS. 

 

Figure 84 : RZ MPU Project Generator (Screen 3) 

 
In the next window, select a project template from the list of available templates. By default, this screen 
shows the templates that are included in your current RZ/A MPU Pack. To add threads, select RTOS, or No 
RTOS if an RTOS is not being used. Once you have selected the appropriate template, click Finish. 

Note: 
The tabs available in the RZ Project Editor depend on the e2 studio version and the layout may vary 
slightly, however the functionality should be easy to follow. 

 

 

Figure 85 : RZ MPU Project Generator (Screen 4) 

 
When the project is created, e2 studio displays a summary of the current project configuration in the RZ MPU 
Project Editor. 
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Figure 86 : RZ MPU Project Editor and available editor tabs 

 
• With the Summary tab, you can see all the key characteristics of the project: board, device, toolchain, 

and more. 
• With the BSP tab, you can change board specific parameters from the initial project selection. 
• With the Clocks tab, you can configure the MCU clock settings for your project. 
• With the Interrupts tab, you can add new user events/interrupts. 
• With the Stacks tab, you can add and configure FSP modules. For each module selected in this tab, the 

Properties window provides access to the configuration parameters, interrupt selections. 
• The Components tab provides an overview of the selected modules. Although you can also add drivers 

for specific FSP releases and application sample code here, this tab is normally only used for reference. 
 
The functions and use of each of the supported tabs is explained in detail in the next section. 

Please note that RZ/A FSP doesn’t support Event Links tab and so, those tabs are grayed out as shown 
above. 
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5.2 Configuring a Project 
Each of the configurable elements in an FSP project can be edited using the appropriate tab in the RZ 
Configuration editor window. Importantly, the initial configuration of the MPU after reset and before any user 
code is executed is set by the configuration settings in the BSP tab. When you select a project template 
during project creation, e2 studio configures default values that are appropriate for the associated board. 
You can change those default values as needed. The following sections detail the process of configuring 
each of the project elements for each of the associated tabs. 

 

5.2.1 Summary Tab 

 

Figure 87 : Configuration Summary tab 

 
The Summary tab, seen in the above figure, identifies all the key elements and components of a project. It 
shows the target board, the device, toolchain and FSP version. Additionally, it provides a list of all the 
selected software components and modules used by the project. This is a more convenient summary view 
when compared to the Components tab. 
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5.2.2 Configuring the BSP 
The BSP tab shows the currently selected board (if any) and device. The Properties view is located in the 
lower left of the Project Configurations view as shown below: 

Note: 
If the Properties view is not visible, click Window > Show View > Properties in the top menu bar. 

 

Figure 88 : Configuration BSP tab 

 
The Properties view shows the configurable options available for the BSP. These can be changed as 
required. The BSP is the FSP layer above the MPU hardware. 

When you click the Generate Project Content button, the BSP configuration contents are written to 
rza_cfg/fsp_cfg/bsp/bsp_cfg.h This file is created if it does not already exist. 

Warning: 
Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked. 

 
5.2.3 Configuring Clocks 
The Clocks tab presents a graphical view of the MPU's clock tree, and each HAL driver uses the settings for 
dedicated numerical calculation. For example, scif_uart driver calculates the communication rate from the 
settings in Clocks tab. Please note that PLLs should be configured by IPL and therefore, PLL settings should 
be consistent with those in IPL. 
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Figure 89 : Configuration Clocks tab 

 
When mousing over the blocks of PLLs on clocks tab, you should see the pop-up message describing this 
precaution. 

 

Figure 90 : Precautions for PLL settings 

 
When you click the Generate Project Content button, the clock configuration contents are written to: 
rza_gen/bsp_clock_cfg.h  

This file will be created if it does not already exist. 

Warning: 
Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked. 
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5.2.4 Configuring Pins 
The pins tab provides flexible configuration of the MPU’s pins. As many pins can provide multiple functions, 
they can be configured on a peripheral basis. For example, selecting a serial channel via the SCIF peripheral 
offers multiple options for the location of the receive and transmit pins for that module and channel. Once 
pins are configured, it is shown as green in the FSP Visualization view. 

 

Figure 91 : Pin Configuration 

 
The pin configurator includes built-in conflict checker. So, if the same pin is allocated to another peripheral or 
I/O function, the pin will be shown as red in the FSP Visualization view and with white cross in a red square 
in the Pin Selection pane and Pin Configuration pane in the main Pins tab. 

In the example shown below, port P13_1 is already used by the Display, and the attempt to connect to this 
pin to the Serial Communication Interface with FIFO (SCIF) results in dangling connection error. To fix this 
error, select another port from the pin drop-down list or disable the Display. 

 

Figure 92 : e2 studio Pin Configurator 

 
When you click the Generate Project Content button, the pin configuration contents are written to: 
ra_gen\bsp_pin_cfg.h. This file will be created if it does not already exist. 

Warning: 
Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked. 
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5.2.5 Configuring Interrupts from the Stacks Tab 
You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt priority. 
Select the driver in the Stacks pane to view and edit its properties. 

 

Figure 93 : Configuring Interrupts in the Stacks tab 

 
5.2.6 Creating Interrupts from the Interrupts Tab 
On the Interrupts tab, the user can bypass a peripheral interrupt set by the FSP by setting a user-defined 
ISR. This can be done by adding a new event via the New User Event button. 

 

Figure 94 : Configuring interrupt in Interrupt Tab 

 
5.2.7 Viewing Event Links 
RZ/A FSP doesn’t support Event Links tab, and it is grayed out. 
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5.2.8 Adding Threads and Drivers 
Every RTOS-based RZ/A FSP Project includes at least one RTOS Thread and a stack of FSP module 
running in that thread. The Stacks tab is a graphical user interface which helps you to add the right modules 
to a thread and configure the properties of both the threads and the modules associated with each thread. 
Once you have configured the thread, e2 studio automatically generates the code reflecting your 
configuration choices. 

For any driver, or, more generally, any module that you add to a thread, e2 studio automatically resolves all 
dependencies with other modules and creates the appropriate stack. This stack is displayed in the Stacks 
pane, which e2 studio populates with the selected modules and module options for the selected thread. 

The default view of the Stacks tab includes a Common Thread called HAL/Common. This thread includes 
the driver for I/O control (IOPORT). The default stack is shown in the HAL/Common Stacks pane. The 
default modules added to the HAL/Common driver are special in that the FSP only requires a single instance 
of each, which e2 studio then includes in every user-defined thread by default. 

In applications that do not use an RTOS or run outside of the RTOS, the HAL/Common thread becomes the 
default location where you can add additional drivers to your application. 

For a detailed description on how to add and configure modules and stacks, see the following sections: 

• Adding and Configuring HAL Drivers 
• Adding Drivers to a Thread and Configuring the Drivers 

 
Only you have added a module either to HAL/Common or to a new thread, you can access the driver's 
configuration options in the Properties view. If you added thread objects, you were able to access the 
objects configuration options in the Properties view in the same way. 

 
5.2.9 Adding and Configuring HAL Drivers 
For applications that run outside or without the RTOS, you can add additional HAL drivers to your application 
using the HAL/Common thread. To add drivers, follow these steps: 

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to HAL/Common 
Stacks. 

2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP. 
3. Select a driver from the menu New Stack > Driver. 
 

 

Figure 95 : e2 studio Project configurator - Adding drivers 

 
4. Select the driver module in the HAL/Common Modules pane and configure the driver properties in the 

Properties view. 
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e2 studio adds the following files when you click the Generate Project Content button: 
• The selected driver module and its files to the rza/fsp directory 
• The main() function and configuration structures and header files for your application as shown in 

the table below. 
 

File Contents Overwritten by 
Generate Project 
Content? 

rza_gen/main.c Contains main() calling generated and user code. 
When called, the BSP has already initialized the MPU 

Yes 

rza_gen/hal_data.c Configuration structures for HAL Driver only modules Yes 
rza_gen/hal_data.h Header file for HAL driver only modules Yes 
src/hal_entry.c User entry point for HAL Driver only code. Add your 

code here 
No 

src/mmu_page_table.c Virtual memory page table settings No 
src/sections.c Rules for section transfer from ROM to RAM No 
src/syscalls.c Low-level processing stub for file I/O functions No 

 
The configuration header files for all included modules are created or overwritten in the folder 
“rza_cfg/fsp_cfg”. 

 
5.2.10 Adding Drivers to a Thread and Configuring the Drivers 
For an application that uses the RTOS, you can add one or more threads, and for each thread at least one 
module that runs in the thread. You can select modules from the Driver dropdown menu. To add modules to 
a thread, follow these steps: 

1. In the Threads pane, click New Thread to add a Thread. 
 

 

Figure 96 : Adding a new RTOS Thread on the Stack tab 
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2. In the properties view, click on the Name and Symbol entries and enter distinctive name and symbol for 
the new thread. 

 
Note: 

e2 studio updates the name of the thread stacks pane to My Thread Stacks. 
 
3. In the My Thread Stacks pane, click on New Stack to see a list of modules and drivers. 
 

 

Figure 97 : Adding Modules and Drivers to a thread 

 
4. Select a module or driver from the list. 
5. Click on the added driver and configure the driver as required by the application by updating the 

configuration parameters in Properties view. To see the selected module or driver and be able to edit its 
properties, make sure the Thread containing the driver is highlighted in the Threads pane. 

 

 

Figure 98 : Configuring Module or Driver properties 
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6. When you press the Generate Project Content button for the example above, e2 studio creates the files 
as shown in the following table: 

 
File Contents Overwritten by Generate 

Project Content? 
rza_gen/main.c Contains main() calling generated and user code. 

When called, the BSP will have initialized the MPU. 
Yes 

rza_gen/my_thread.c Generated thread “my_thread” and configuration 
structures for modules added to this thread. 

Yes 

rza_gen/my_thread.h Header file for thread “my_thread” Yes 
rza_gen/hal_data.c Configuration structures for HAL Driver only 

modules. 
Yes 

rza_gen/hal_data.h Header file for HAL driver only modules. Yes 
src/hal_entry.c User entry point for HAL Driver only code. Add your 

code here. 
No 

src/my_thread_entry.c User entry point for thread “my_thread”. Add your 
code here. 

No 

 
5.2.11 Configuring Threads 
If the application uses RTOS, the Stacks tab can be used to simplify the creation of RTOS threads, 
semaphores, mutexes, and event flags. The components of each thread can be configured from the 
Properties view as shown below: 

 

Figure 99 : New Thread Properties 

The Properties view contains settings which are common for all Threads (Common) and settings for this 
particular thread (Thread). 
For this thread instance, the thread's name and properties (such as priority level or stack size) can be easily 
configured. e2 studio checks that the entries in the property field are valid. For example, it will verify that the 
field Priority, which requires an integer value, only contains numeric values between 0 and 9. 
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To add RTOS resources to a Thread, select a thread and click on New Object in the Thread Objects pane. 
The pane takes on the name of the selected thread, in this case My Thread Objects. 

 

Figure 100 : Configuring Thread Object Properties 

 
Make sure to give each thread object a unique symbol by updating the Symbol entries in 
the Properties view. 
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5.3 Reviewing and Adding Components 
The Components tab enables the individual modules required by the application to be included or excluded. 
Modules common to all RZ/A MPU projects are preselected. All modules that are necessary for the modules 
selected in the Stacks tab are included automatically. You can include or exclude additional modules by 
ticking the box next to the required component. 

 

Figure 101 : Components Tab 

 
By clicking the Generate Project Content button, the .c and .h files for each selected component are copied 
into the following folders: 

• rza/fsp/inc/api 
• rza/fsp/inc/instances 
• rza/fsp/src/bsp 
• rza/fsp/src/<Driver_Name> 

 
e2 studio also creates configuration files in the rza_cfg/fsp_cfg folder with configuration options set in the 
Stacks tab. 

 

5.4 Debugging the Project 
Once your project builds without errors, you can use the Debugger to download your application to the board 
and execute it. 

To debug an application, follow these steps: 

1. On the drop-down list next to the debug icon, select Debug Configurations. 
 

 

Figure 102 : Select of Debug Configurations 
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2. In the Debug Configurations view, click on your project listed as MyProject Debug_Flat. 
 

 

Figure 103 : Debug Configuration Window 

 
3. Please set load images and set Reset after download setting to Yes as shown below: 
 

 

Figure 104 : Debug Setting 

 
4. Connect the board to your PC via a standalone Segger J-Link debugger and click Debug. 
 
Note: 

For details on using J-Link and connecting the board to the PC, see 3.2.2.JTAG connection. 
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5.5 Modifying Toolchain Settings 
There are instances where it may be necessary to make changes to the toolchain being used (for example, 
to change the optimization level of the compiler or add a library to the linker). Such modifications can be 
made within e2 studio through the menu Project > Properties > Settings when the project is selected. The 
following screenshot shows the settings dialog for the GNU Arm toolchain. This dialog will look slightly 
different depending upon the toolchain being used. 

 

Figure 105 : e2 studio Project toolchain settings 

 
The scope for the settings is project scope which means that the settings are valid only for the project being 
modified. 

The settings for the linker which controls the location of the various memory sections are contained in a 
script file specific for the device being used. This script file is included in the project when it is created and is 
found in the created project. (for example, script/rza3ul_smarc_qspi_xip.ld). 

 

5.6 Importing an Existing Project into e2 studio 
1. Launch e2 studio. 
2. Open an existing Workspace to import the project and skip to step d. If the workspace does not exist, 

proceed with the following steps: 
 

a. At the end of e2 studio startup, you will see the Workspace Launcher Dialog box as shown in the 
following figure. 

 

 

Figure 106 : Workspace Launcher dialog 
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b. Enter a new workspace name in the Workspace Launcher Dialog as shown in the following figure. 

e2 studio creates a new workspace with this name. 
 

 

Figure 107 : Workspace Launcher dialog - Select Workspace 

 
c. Click [Launch]. 
d. When the workspace is opened, you may see the Welcome Window. Click on the Workbench 

arrow button to proceed past the Welcome Screen as seen in the following figure. 
 

 

Figure 108 : Workbench arrow button 

 
3. You are now in the workspace that you want to import the project into. Click the File menu in the menu 

bar, as shown in the following figure: 
 

 

Figure 109 : Workbench arrow button 

 
4. Click [Import] on the [File] menu or “Import project” on Project Explorer, as shown in the following figure: 
 

 

Figure 110 : File drop-down menu 
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5. In the Import dialog box, as shown in the following figure, choose the General option, then Existing 

Projects into Workspace, to import the project into the current workspace. 
 

 

Figure 111 : Project Import dialog with "Existing Projects into Workspace" option selected 

 
6. click [Next >] 
7. To import the project, use either Select archive file or Select root directory. 

First, choose Select root directory as shown below: 
 

 

Figure 112 : Import Existing Project dialog 1 - Select root directory 
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8. Click [Browse...]. 
9. Choose the directory of the project you would like to import to specify the directory as root directory. 
10. Select the project for import. 
11. Click [Open]. 
12. Select the project to import from the list of [Projects:] as shown below: 
 

 

Figure 113 : Import Existing Project dialog 2 – Select the project to be imported 

 
13. Click [Finish] to import the project. 
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6. Notes on development 
6.1 Getting USB Hub to be workable with USBX 
When using USB Hub with USBX, please follow the pro shown below: 

1. Copy rza/microsoft/azure-rtos/usbx/common/core/inc/ux_user_sample.h to the directory 
rza/fsp/src/rm_usbx_port and rename it to ux_user.h. 

2. Add the definitions listed below to ux_user.h. 
 
#define UX_MAX_CLASS_DRIVER  3 
#define UX_MAX_ED     80 
#define UX_MAX_TD     128 
#define UX_MAX_ISO_TD    128 
 

3. Add the following definition to rza_azurertos_sample/rza/fsp/src/rm_usbx_port/ux_port.h. 
 
#define UX_INCLUDE_USER_DEFINE_FILE 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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